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Legal Disclaimer 
The product described in this documentation may be connected to, and/or communicate 
information and data via, a network interface, which should be connected to a secure 
network. It is your sole responsibility to ensure a secure connection to the network and to 
establish and maintain appropriate measures (such as but not limited to the installation of 
firewalls, application of authentication measures, encryption of data, installation of 
antivirus programs, etc.) to protect the product, the network, your systems, and the 
interface against any kind of security breach, unauthorised access, interference, intrusion, 
leakage, damage, or corruption or theft of data. We are not liable for damages or losses 
related to any such security breach, unauthorised access, interference, intrusion, leakage, 
damage, or corruption or theft of data. 



MineScape 2023 Update 1 What's New 

 
 

3 
 

Contents 
What's New ............................................................................................................................................................ 5 

Support for Underground Scheduling with Tactical Scheduler ........................................ 5 

Mining Blocks, the next generation of Bench Blocks .............................................................. 6 

Rapid Slicer ......................................................................................................................................................... 9 

Survey Server Manager ............................................................................................................................... 11 

Start Page Enhancement ......................................................................................................................... 12 

Region-Adaptive Content .................................................................................................................... 12 

CAD ......................................................................................................................................................................... 13 

Interactive Boolean .................................................................................................................................. 13 

Update DTM ................................................................................................................................................. 14 

Create Surface Mesh from Design Data .................................................................................... 14 

Automatically remove triangle anomalies with Mesh Despike ................................... 15 

Hotkeys Updates ....................................................................................................................................... 16 

Small Enhancements .............................................................................................................................17 

Elevated Mesh File Performance ...............................................................................................17 

Explore and Modify Multi-Mesh Efficiently .........................................................................17 

Interactive Filter for Multi-Mesh ................................................................................................ 18 

Polygon Balancing Output Format Updated ................................................................... 18 

Height Cue in Mesh Property...................................................................................................... 18 

Automatic Pick Cursor Colour Adjustment ........................................................................ 19 

Increase in Supported Total Colours ...................................................................................... 20 

Geology ................................................................................................................................................................. 21 

New Import CSV Options in GDB.................................................................................................... 21 

New Trace Types Added to GDB for Enhanced Data Visualisation........................... 23 

Resource Classification ......................................................................................................................... 25 

Surface Engineering................................................................................................................................... 26 

App List Update ........................................................................................................................................ 26 

Dump Mesh ................................................................................................................................................ 26 

Place Dragline by Swing Angle ....................................................................................................... 27 

3D Display of Dragline Section ....................................................................................................... 28 

Engineering Multi-Mesh ..................................................................................................................... 28 

Engineering Optimization...................................................................................................................... 30 



MineScape 2023 Update 1 What's New 

 
 

4 
 

Automatic Price per Iteration .......................................................................................................... 30 

Scheduling ......................................................................................................................................................... 31 

New Mining Blocks App Added ....................................................................................................... 31 

Added Recalculate Sequence Buttons ........................................................................................ 31 

New Clear Button in the Pivot Grid ................................................................................................ 31 

New Pit Face Positions as a Reporting Method .................................................................... 32 

Drone Surveying ............................................................................................................................................ 33 

Classify Ground .......................................................................................................................................... 33 

Classify Buildings and Vegetations ............................................................................................... 33 

Classify Poles .............................................................................................................................................. 34 

Plot Designer ................................................................................................................................................... 35 

 



MineScape 2023 Update 1 What's New 

 
 

5 
 

What's New 
The following section lists the new functionality, features, and defect corrections 

delivered with MineScape 2023 Update 1. 

 

Support for Underground Scheduling with 

Tactical Scheduler 
Users can now create underground (UG) scheduling in Tactical Scheduler. To 

support this new capability, the UG Coal App and Tactical Scheduler App have 

been enhanced in the following ways: 

• Two new forms, the Create UG Solids and Model Resource Forms, have 

been added to the UG Coal App. 

 
New Group in the UG Coal Tab 

These forms allow users to generate UG mining blocks from existing 

underground designs, serving as vital input for scheduling once reserved. 

To access these forms, click the UG Coal Tab and locate the UG Solids 

Group. Two new Options should be present: Create and Run Reserves. 

 
New Forms to Create UG Mining Blocks 
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• In the Scheduler App, the New Schedule Project wizard now provides a 

new option called Mining Type: Surface and Underground. 

 
Mining Type Selection 

 

Mining Blocks, the next generation of Bench 

Blocks 
The Mining Blocks App, formerly known as the Bench Blocks App, has undergone 

significant enhancements in this release. Beyond its original capability of 

generating single benches, the App now offers options to create mining blocks 

from multiple benches or an entire pit. It has also been improved in the following 

ways: 
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• The Mining Blocks Ribbon is updated to accommodate the new workflow. 

 
Mining Blocks Ribbon 

• The Mining Blocks Form has been intuitively enhanced, allowing the name 

of the form and its sections to dynamically adjust based on the selected 

mining type and its unique workflow. 

 
Create Mining Blocks for the Pit Form 

o Single Bench – This option generates a mesh file with a single intact 

bench, which can later be cut into mining blocks using the options 

within the Interactive Group. 

o Multi-Benches and Pit – These options are integrated with the 

Rapid Slicer Tool, generating a mesh file containing mining blocks. 

The Rapid Slicer Tool is accessible within the Between Benches 

Section; for more details, refer to the information on the Rapid Slicer 

below. 

 
Rapid Slicer Tool in the Between Benches Section 
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• The Solid/Outline Option allows users to toggle between displaying or 

hiding mining blocks outlines for better viewing of the benches, slices, and 

intervals. 

 
Solid/Outline 

• The Calculate Reserve Form is updated to accommodate reserve and 

volume calculations for Multi-Benches and Pit scenarios. 

The Naming Section automatically adjust accordingly to the selected 

scenario, as follows: 

o Single Bench – enables users to select blocks for naming and 

construct names for each block by defining prefixes for each 

element and material, along with its order arrangement. 

o Multi-Benches and Pit – allows users to define the order 

arrangement of elements and material hierarchy. 

 
Naming Section for Multi-Benches and Pit Scenario 
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Rapid Slicer 
This update introduces the Rapid Slicer, an interactive mesh slicer tool designed 

to effortlessly divide benches into mining blocks. Users can easily customise slices 

into different sizes and cut angles, ensuring precision and flexibility in block 

formation. Once a Rapid Slicer is defined, users can save and reuse it across 

multiple benches, significantly saving time in the process. 

 
Interactive Block Sizing 

The Rapid Slicer Tool is accessible within the Between Benches Section of the 

Create Mining Blocks for Multi-Benches and the Pit Form. 

 
Between Benches Section of the Create Mining Blocks Form  
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It is also accessible within the Dump Mesh Section of the Dump Mesh Form. 

 
Dump Mesh Section of the Dump Mesh Form 

To reuse the Rapid Slicer, users can reopen the file via the Tool within the Forms 

or by right-clicking on the Rapid Slicer file under the Rapid Slicer node and select 

Edit. 

 
Rapid Slicer Node in MineScape Explorer 

Users can edit the slicer grid using the Slicer Toolbox located at the bottom right 

corner of the slicer grid, providing four input modes. 

 
Slicer Toolbox 
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Survey Server Manager 
The new MineScape Survey Server Manager allows users to easily configure and 

manage the services of the Survey Server, which includes checking the server 

status, changing the settings, updating the application, checking the logs, and 

more.  

 
MineScape Survey Server Manager 

For more information, refer to the Survey Server Installation Guide.  

https://minescape.azureedge.net/portal-email/M2023/Update1/MineScape_2023_Survey_Server_Installation_Guide_EN.pdf
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Start Page Enhancement 
The MineScape Start Page has been enhanced in the following way: 

Region-Adaptive Content 

Users can now access content based on their chosen Windows region format. 

With the addition of new regions, MineScape now supports 16 languages, 

including English (Australia, Canada, New Zealand, South Africa, the United 

States), Russian, Polish, Chinese, French, German, Hindi (Indian), Bahasa 

Indonesia, Portuguese (Brazil), Spanish (Spain), Thai (Thailand) and Vietnamese. 

Access news, videos, guides, and feature articles tailored to the users’ region, 

ensuring them the content that suits their preferences and needs. 

 
Region Window 
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CAD 
The CAD App has been improved in the following ways: 

Interactive Boolean 

The Interactive Option allows users to perform Boolean operations, such as 

intersecting, combining, and finding the difference between two meshes or 

multi-mesh, and choose the desired outputs. 

 
Interactive Boolean 

The difference between Interactive and other Boolean Options, such as Intersect 

and Difference, is that Interactive allows users to select the desired output 

portions of the mesh. In contrast, the other Boolean Options mandate users to 

follow specific orders when selecting meshes. 

Find the Interactive Option within the Boolean Group of the Mesh Tab.  

 
Interactive Option 



MineScape 2023 Update 1 What's New 

 
 

14 
 

Update DTM 

Update DTM allows users to manipulate two surface meshes to create a 

combined mesh output that visualises a dump or hole through elevating and 

excavating a surface mesh against the other. 

 
Before and After Excavation 

The two ways to access the Update DTM Option are:  

• Within the Boolean Group of the Mesh Tab 

 
Update DTM Option in Mesh Tab 

• Within the Rapid Update Group of the Open Cut Tab  

 
Update DTM Option in Open Cut Tab 

 

Create Surface Mesh from Design Data 

The Create Surface Mesh from Design Data Feature allows users to create 

surface meshes from various design files without having to open the source 

design file and layer on the CAD Window. The output can be a single mesh or a 

multi mesh. 

Previously, users can also create a surface mesh by utilising the Create Surface 

Feature. However, since the Create Surface Mesh from Design Data Feature is a 
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module, users can now create surfaces from batch files, instead of the previous 

manual process. 

 
Three Surface Mesh 

Find the Create Surface from Design Data Option within the Surface Mesh 

Group of the Mesh Tab: 

 
From Design Data Option 

 

Automatically remove triangle anomalies with Mesh Despike 

Unwanted triangles within meshes can be detected and removed automatically 

using the Mesh Despike Feature. 

 
Before and After Comparison of a Successful Despike Function 
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Running this function will produce a new refined mesh file so that the original 

mesh is preserved. To access it, click the Mesh Tab and click Despike in the 

Surface Mesh Group. A new form should appear. 

 
Mesh Despike Form 

 

Hotkeys Updates 

Updated Hotkeys for the purpose of switching between Apps are listed in the 

table below:  

Hotkey Description 

D0 Activate the 10th App in the list. 

D7 Activate the 7th App in the list. 

D8 Activate the 8Th App in the list. 

D9 Activate the 9th App in the list. 

 
Updated Hotkeys for the purpose of viewing and rotation are listed in the table 

below:  

Hotkey Description MineScape Path 

Shift+D0 Rotate the Y axis by 180 

degrees 

RIBBON: View / Animation / 

Rotation / Y Axis 180 
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Hotkey Description MineScape Path 

Shift+D7 Rotate the X axis by 90 

degrees 

RIBBON: View / Animation / 

Rotation / X Axis 90 

Shift+D8 Rotate the Y axis by 90 

degrees 

RIBBON: View / Animation / 

Rotation / Y Axis 90 

Shift+D9 Rotate the Z axis by 90 

degrees 

RIBBON: View / Animation / 

Rotation / Z Axis 90 

 

Small Enhancements 

Elevated Mesh File Performance 

MineScape latest update brings significant performance enhancements to mesh 

file management, offering a smoother experience when loading, unloading, and 

applying interactive filters. Furthermore, the mesh Relimit Option now 

accommodates poly3D elements as inputs, increasing the flexibility of your 

workflows. 

 

Explore and Modify Multi-Mesh Efficiently 

The multi-mesh in MineScape has undergone enhancements to offer a more 

interactive and streamlined experience. Key improvements include: 

• Detailed mesh listing - Each individual mesh within a multi-mesh is now 

listed in the Display Dock. Clicking the arrow next to the multi-mesh name 

reveals a comprehensive list of all constituents meshes. 

• Interactive highlighting - Selected meshes within a multi-mesh are 

highlighted in both the Display Dock and the CAD Window. This can be 

done seamlessly from either the Display Dock or the CAD Window. 

• Selective property updates - Users can selectively update properties for 

specific meshes within a multi-mesh, with changes reflected across all 

instances. 
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Interactive Filter for Multi-Mesh 

Interactive Filter can now be applied to multi-meshes that contains metadata 

within a mesh folder. Users simply need to choose the desired multi-mesh, and 

the dropdown list in the Metadata Field within the Interactive Filter Dock will 

automatically update based on the metadata present in the selected multi-mesh. 

 

Polygon Balancing Output Format Updated 

The output format for Polygon Balancing has been updated. Formerly 

generating triangles, it now produces a mesh. 

 

Height Cue in Mesh Property 

As part of the Properties Dock for meshes, users can now set the Height Cue, 

which means that users can colour the meshes according to the height of the 

mesh data.  

 
Height Cue Field 
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Automatic Pick Cursor Colour Adjustment 

For improved visual clarity, the pick cursor now automatically adjusts its colour to 

complement the viewport background. 

• The pick cursor will appear in a dark colour when the viewport background 

is a gradient or light-coloured.  

 
Dark Pick Cursor 

• Conversely, the pick cursor will adopt a light colour when the viewport 

background is dark.  

 
Light Pick Cursor 
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• Additionally, the pick cursor will be coloured blue when the viewport 

background is grey.  

 
Blue Pick Cursor 

 

Increase in Supported Total Colours 

MineScape now supports 8000 colours in its palette, a significant increase from 

the previous limit of 1000. 



MineScape 2023 Update 1 What's New 

 
 

21 
 

Geology 
The Geology Product has been enhanced in the following ways: 

New Import CSV Options in GDB  

Users now have the option to independently import and update CSV files or utilise 

a predefined data template. 

The CSV, CSV Using Template, From CSV, and From CSV Using Template 

Options are added under the Import and Update Groups of the Data Tab within 

the GDB App.  

 
Data Tab 

 
Import CSV Form 
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Import CSV Using Template Form 

 
Update from CSV Form  

 
Update from CSV Using Template Form 
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This improvement also allows users to customise the import processes through 

the Import Settings Form, accessible via the Settings Button in each form. 

 
Import Settings Form 

New Trace Types Added to GDB for Enhanced Data Visualisation 

The latest enhancement in MineScape GDB allows users to efficiently store and 

visualise dip line and induration drill hole information for cross-section 

interpretations, across both 2D and 3D graphics displays. 

6  
Dip Line and Induration Trace Type 
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The DIP LINE trace type utilises the dip angle and azimuth fields to render angled 

dip lines as their apparent dip as viewed from the specified cross-section bearing. 

Dip line traces employ colour coding based on a custom control field such as the 

dip quality. 

 
Updated Attribute Display Parameters Form 

Meanwhile, the INDURATION trace type indicates hardness changes with 

horizontal lines drawn at the initial depth of each induration record. The colouring 

of these lines is determined by a custom control field such as a text structure code 

or numeric induration value. 

When visualising the drill hole data, users can apply a data density filter within the 

field display specifications to reduce dense data to a manageable size based on a 

minimum depth change. 
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Resource Classification 

Users can now define the minimum drill hole data to include when generating 

Polygon of Influence. This option is available when the Omit polygons for 

isolated points checkbox is selected. 

 
Create Resource Classification Form 
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Surface Engineering 
The Surface Engineering Product has been enhanced in the following ways: 

App List Update 

Under the MineScape Surface Engineering App List, three Apps have been 

added, which are – Mining Blocks, Reconciliation, and Reclamation.  

 
Surface Engineering App List 

 

Dump Mesh 

Enhanced with new features, the Dump Mesh Form now more accurately 

replicates actual conditions, enhances flexibility, and adds precision to the 

creation of dump mining blocks. The Dump Mesh Form has been improved with 

the following features: 

 
Solid Mesh Section 
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• Reordered sections to facilitate a more efficient workflow. 

• Now supports topography mesh as its base. 

• Added the option to apply boundary limits. 

 
Bench Mesh Section 

• Introduced the ability to directly use a solid if it already exists and skip the 

solid-generating process. 

• Enabled the splitting of benches using bench specifications, allowing for a 

precise cut at the desired elevation. 

• Integrated with Rapid Slicer to enable a rapid, interactive, and customised 

slicing process. 

 

Place Dragline by Swing Angle 

The new Swing Angle feature in MineScape Dragline allows users to interactively 

position the dragline within a section by entering dump and cut angles. This 

functionality can determine a dragline position with the highest productivity, 

minimum swing angle, and efficient placement of dumped material in the 

available pit space. Users can evaluate dragline locations against its capabilities for 

material replacement. 
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3D Display of Dragline Section 

Users can now view Dragline sections in 3D mode, applicable to DRAG SURFACE 

and DRAG AREA. Previously displayed as a static single line without rotation 

capability, these sections now transform into a ribbon within the 3D View, their 

width corresponding to the defined Section Width and allowing rotation. The 3D 

View Option is within the Display Group of the Design Tab. 

 
Dragline Section 3D Preview 

 

Engineering Multi-Mesh 

Generating samples from the Engineering Multi-Mesh, which can be used for 

reserve calculations, now offers the option to include or exclude the bench. 

Additionally, the output now supports metadata by selecting the Output to Multi-

Mesh Option. 

 
Reserve by Bench and Output to Multi-Mesh Option 
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This enhancement applies to sample generating Forms within the Open Cut and 

Reconciliation App. 

  
Open Cut App Reconciliation App 

 



MineScape 2023 Update 1 What's New 

 
 

30 
 

Engineering Optimization 
The Pit Optimization App has been enhanced in the following way: 

Automatic Price per Iteration 

The Pit Optimization Form now supports automatic calculation for price per 

iteration, eliminating the need for manual calculations outside the system. 

MineScape now handles the iteration calculation automatically, a process that was 

previously done manually by users outside MineScape. 

 
Pit Optimization Form 
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Scheduling 
The Tactical Scheduler App has been enhanced in the following ways: 

New Mining Blocks App Added 

The Mining Blocks App, previously called Bench Blocks, has been removed from 

the Scheduler Ribbon within the Tactical Scheduler App and turned into a 

standalone App. 

 
Mining Blocks App Added as a Standalone App 

 

Added Recalculate Sequence Buttons 

For scheduling that uses the Equipment Utilisation method, a new Recalculate 

Sequence button has been added to the following forms in the Schedule Setup 

Tab: 

• Utilisation & Availability 

• Equipment Rates 

• Truck Wait Times 

• Truck Cycle Time 

• Truck Load Factors 

• Production Rates 

• Schedule Hours 

The Recalculate Sequence Button allows users to modify the schedule 

configurations without the need to delete the current sequence and repick the 

blocks. 

New Clear Button in the Pivot Grid 

A Clear Button has been added to the Pivot Grid that allows user to reset the pivot 

table and return the selected filter fields to their default positions. 
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New Pit Face Positions as a Reporting Method 

Pit face positions can be generated in the form of boundary lines. This output 

provides X, Y, Z coordinates that are helpful for users to put markers in their pit 

based on the latest schedule progress. The outputs are a design layer containing 

boundary lines, contours, and mesh DTM reflecting the latest schedule progress. 

Pit face positions can be generated by: 

• Progress – based on the current state of the animation 

• Date – based on the selected schedule date 

 
Updated Contour 

 
Updated Mesh DTM 
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Drone Surveying 
Several of the Classify Forms within the Point Cloud App have been updated in 

the following ways: 

Classify Ground 

The Remove Near Non-Ground and Convergence Fields have been removed 

from the Classify Ground Form. The current Classify Ground Form looks like the 

below: 

 
Classify Ground Form 

 

Classify Buildings and Vegetations 

The Mahalonobis Distance Field has been changed to Maximum Standard 

Deviations Field to improve clarity. There has been an added Points Unit in the 

Minimum Cluster Size Field. The current Classify Buildings and Vegetations 

Form looks like the below: 
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Classify Buildings & Vegetations Form 

 

Classify Poles 

The Maximin X Distance Field has been changed to Maximum Horizontal Extent 

of Pole Field. The current Classify Poles Form looks like the below:  

 
Classify Poles Form 
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Plot Designer 
The Plot Designer App is now accessible from the App List. When users select the 

Plot Designer App, MineScape will open the Plotting Tab. 

 
Plot Designer App and Plotting Tab 


